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Chapter 1: Overview
The DSO (Digital Stage Output) card provides eight channels 
of digital outputs to your VENUE system. The eight digital 
outputs are available via four two-channel AES/EBU XLR con-
nectors along with an ADAT optical interface, providing si-
multaneous output to both connector types.

The DSO card is installed in the VENUE Stage Rack. Up to six 
DSO cards may be installed in a Stage Rack, providing a total 
of 48 channels of digital outputs. 

For DSO card installation instructions, see Chapter 2, “Install-
ing Option Cards.”

DSO Card Components
The DSO card package includes the following items:

• DSO card

• Mounting screws

• Avid Registration Information Card

DSO Card Capabilities and Features
• Eight channels of digital outputs via four two-channel 

AES/EBU XLR3-male connectors

• Eight channels of ADAT optical digital outputs via one 
ADAT TOSLINK connector

• Simultaneous output to both AES/EBU outputs and 
ADAT optical output

• Automatic muting for system protection

• Signal and Mute LEDs for each AES/EBU channel pair
DSO Card
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System Requirements and 
Compatibility
Avid can only assure compatibility and provide support for 
hardware and software it has tested and approved. 

For complete system requirements and a list of qualified com-
puters, operating systems, hard drives, and third-party de-
vices, visit:

www.avid.com/compatibility

Registration
Review the enclosed Registration Information Card and fol-
low the instructions on it to quickly register your purchase on-
line. By registering, you become eligible to receive the follow-
ing:

• Technical support information

• Software update and upgrade notices

• Hardware warranty information
DSO Digital Output Card2
Conventions Used in This Guide
All VENUE guides use the following conventions to indicate 
menu choices and key commands:
:

The following symbols are used to highlight important infor-
mation:

Convention Action

File > Save Session In Pro Tools, choose 
Save Session from the 
File menu

Options > System Config In the VENUE software 
screen, click Options to 
display the Options 
page, then click the Sys-
tem Config tab.

Ctrl+N Hold down the Control 
key and press the N key

Ctrl-click Hold down the Control 
key and click the mouse 
button

User Tips are helpful hints for getting the 
most from your system.

Important Notices include information that 
could affect data or performance.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this or other guides.



About www.avid.com
The Avid website (www.avid.com) is your best online source 
for information to help you get the most out of your system. 
The following are just a few of the services and features avail-
able. 

Product Registration Register your purchase 
online. 

Support and Downloads Contact Customer Success (technical 
support); download software updates and the latest online 
manuals; browse the Compatibility documents for system re-
quirements or search the online Knowledgebase. 

Training and Education Study on your own using courses avail-
able online or find out how you can learn in a classroom set-
ting at a certified Avid training center. 

Products and Developers Learn about Avid 
products; download demo software or learn about our Devel-
opment Partners and their plug-ins, applications, and hard-
ware. 

News and Events Get the latest news from Avid or sign up for 
a product demo. 

Pro Tools Accelerated Videos Watch the series of free tutorial 
videos. Accelerated Videos are designed to help you get up and 
running with Pro Tools and its plug-ins quickly. 

Live Sound Webinars Watch free tutorial videos and 
VENUE-specific webinars to learn from the experts. 

To learn more about these and other resources available from 
Avid, visit our website (www.avid.com). 
Chapter 1: Overview 3
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Chapter 2: Installing Option Cards
This chapter provides instructions for installing option cards 
in a Stage Rack. The following option cards can be installed in 
a Stage Rack:

SRI Stage Rack Input Card Provides eight analog mic/line 
inputs.

DSI Digital Stage Input Card Provides eight digital inputs.

SRO Stage Rack Output Card Provides eight analog line 
outputs.

DSO Digital Stage Output Card Provides eight digital outputs.

ANO A-Net Output Card Provides 16 channels of outputs to Av-
iom® Pro16™ personal mixers and devices.

Installation is the same regardless of the type of Stage Rack op-
tion card, with the exception of the ANO A-Net card. Up to six 
input cards of either type can be installed in stots A–F, and up 
to six DSO or SRO output cards of either type can be installed 
in slots G–M.

Installing Option Cards in the Stage 
Rack
Stage Rack option cards are installed in the Stage Rack and 
connected to a ribbon cable in the Stage Rack. 

To install an SRI, SRO, DSI or DSO card:

1  Shut down your system.

2  Power down your Stage Rack. 

3  Disconnect all cables from the Stage Rack. 

For information on installing and using the ANO A-Net 
card, see the A-Net Output Card Guide.
4  Remove the Stage Rack’s back panel cover by unscrewing its 
mounting screws (#1 Phillips).

5  On the front panel of the Stage Rack, locate the slot where 
you want to install the option card. 

Input Cards SRI or DSI cards may be installed in slots A–F only. 

Output Cards SRO or DSO cards may be installed in slots G–M 
only. 

Up to six input cards of either type can be installed in slots 
A–F, and up to six output cards of either type can be installed 
in slots G–M.

6  Remove the card slot cover by removing the four screws 
holding it in place. Keep the screws nearby for securing the 
option card to the Stage Rack later. 

Stage Rack main back panel

Stage Rack front panel

Back panel

Mounting screws (remove all)

Option card

(remove)
slot cover
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7  Remove the option card from its packing material. Hold the 
card by its edges. 

8  Gently slide the option card into the option card slot. Use 
two hands, one to guide the card from the back of the Stage 
Rack, and the other to push the card in from the front of the 
Stage Rack. Align the guide pin at the top rear of the card with 
the corresponding hole in the back of the Stage Rack chassis. 

Stage Rack option card showing brackets and connector 

Installing a Stage Rack option card in the Stage Rack (SRO card shown)

Ribbon cable
connector

Mounting
guide pin

Mounting
bracket
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9  When the option card is seated in its slot, secure it to the 
Stage Rack chassis from the back of the Stage Rack with a pro-
vided mounting screw. 

10  Secure the option card to the front panel of the Stage Rack 
using four provided mounting screws.

Securing a Stage Rack option card to the Stage Rack chassis

Securing a Stage Rack option card to the Stage Rack front panel

Guide pins



11  Connect the option card to its corresponding ribbon cable 
connector. Make sure the pins are oriented correctly. Secure 
the connection by moving the retaining clips on each side of 
the connector in ward. Check to make sure the cable is con-
nected securely. 

Connecting a Stage Rack option card to the Stage Rack ribbon cable
Confirming Installation
After you have installed an option card, you should confirm 
that you have installed it properly. You can confirm installa-
tion by checking your system hardware status.

To complete and confirm installation:

1  Reattach the Stage Rack’s back panel.

2  Reconnect the power, Snake cable, and any audio cables to 
the Stage Rack.

3  Turn on your VENUE system.

4  Go to the Options > Devices tab to view your system hard-
ware status. The newly installed option card should appear in 
the Stage Rack graphic.

The newly installed option card’s inputs or outputs should 
also become available in the corresponding “Stage” tab in the 
Patchbay. 

Detail of Devices page indicating presence of a DSO card

For more information on configuring and routing inputs 
and outputs, see the main VENUE guide that came with 
your system. 
Chapter 2: Installing Option Cards 7
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Chapter 3: Specifications

Audio and Electrical Specifications
DSO Digital Outputs
Parameter Specifications Limit Units Condition/ Comment

Connector (x4) XLR3-Male

Format AES3 (AES/EBU)

Word length 24 bit

Impedance 110 ohm

Level ~3.6 Vpp max, i.e., +/- 1.8V

Sample rate 48 kHz No sample rate conversion

Channel status info Pro Audio 48k, no emphasis

Dithering No
LEDs
Signal LEDs (AES 1/2–7/8)

One green and one red Signal LED per output pair indicate output signal status as follows:

DSO ADAT Digital Output

Parameter Specifications Limit Units Condition/ Comment

Connector (x1) TOSLINK Optical

Format ADAT 8 Channel

Word length 24 bit

Sample rates 48 kHz No sample rate conversion

Dithering No
Sig LEDs

Sig LEDs Indicates

Red Hardware mute (automatically during power up and power down, or via Mute all Stage Output action)

Green Signal present
Chapter 3: Specifications 9
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Appendix A: Compliance Information
Environmental Compliance

Disposal of Waste Equipment by Users in the 
European Union

This symbol on the product or its packaging indicates that this product must not 
be disposed of with other waste. Instead, it is your responsibility to dispose of 
your waste equipment by handing it over to a designated collection point for the 
recycling of waste electrical and electronic equipment. The separate collection 
and recycling of your waste equipment at the time of disposal will help conserve 
natural resources and ensure that it is recycled in a manner that protects human 
health and the environment. For more information about where you can drop off 
your waste equipment for recycling, please contact your local city recycling office 
or the dealer from whom you purchased the product.

Proposition 65 Warning

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires 
the following disclosure statement: “Perchlorate Material – special handling may 
apply, See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

This product contains chemicals, including lead, 
known to the State of California to cause cancer and 
birth defects or other reproductive harm. Wash hands 
after handling.
EMC (Electromagnetic Compliance)
Avid declares that this product complies with the following standards regulating 
emissions and immunity:
• FCC Part 15 Class B
• EN55103-1 E3
• EN55103-2 E3
• AS/NZS CISPR Class B
• CISPR 22 Class B

FCC Compliance for United States

Radio and Television Interference

This equipment has been tested and found to comply with the limits for a Class 
B digital device, pursuant to Part 15 of the FCC Rules. 

Australian Compliance

DECLARATION OF CONFORMITY
We, Avid, 2001 Junipero Serra Boulevard
Daly City, CA 94014-3886, USA
650-731-6300
declare under our sole responsibility that the product
DSO Option Card
complies with Part 15 of FCC Rules.  
Operation is subject to the following two conditions:  
(1) this device may not cause harmful interference, and 
(2) this device must accept any interference received, 
including interference that may cause undesired operation.

Communication Statement
NOTE: This equipment has been tested and found to comply 
with the limits for a Class B digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a 
particular installation.  If this equipment does cause harmful 
interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is 
encouraged to try and correct the interference by one or 
more of the following measures:
• Reorient or locate the receiving antenna.
• Increase the separation between the equipment and 

receiver.
• Connect the equipment into an outlet on a circuit 

different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician 

for help.
Any modifications to the unit, unless expressly approved by 
Avid, could void the user's authority to operate the 
equipment.

Avid
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Canadian Compliance

This Class A digital apparatus complies with Canadian ICES-003

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du 
Canada

CE Compliance

(EMC and Safety)

Avid is authorized to apply the CE (Conformité Europénne) mark on this compliant 
equipment thereby declaring conformity to EMC Directive 89/336/EEC and Low 
Voltage Directive 2006/95/EEC.
DSO Digital Output Card12
Safety Compliance

Safety Statement

This equipment has been tested to comply with USA and Canadian safety 
certification in accordance with the specifications of UL Standards: UL60065 7th 
/IEC 60065 7th and Canadian CAN/CSA C22.2 60065:03. Avid Inc., has been 
authorized to apply the appropriate UL & CUL mark on its compliant equipment.

Warning

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance with the 
manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves, 
or other equipment (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A 
polarized plug has two blades with one wider than the other. A grounding type 
plug has two blades and a third grounding prong. The wide blade or the third 
prong are provided for your safety. If the provided plug does not fit into your 
outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect power cords from being walked on or pinched particularly at plugs, 
convenience receptacles, and the point where they exit from the equipment.

11) Only use attachments/accessories specified by the manufacturer.

12) For products that are not rack-mountable: Use only with a cart, stand, tripod, 
bracket, or table specified by the manufacturer, or sold with the equipment. 
When a cart is used, use caution when moving the cart/equipment combination 
to avoid injury from tip-over.

13) Unplug this equipment during lightning storms or when unused for long 
periods of time. 

14) Refer all servicing to qualified service personnel. Servicing is required when 
the equipment has been damaged in any way, such as power-supply cord or plug 
is damaged, liquid has been spilled or objects have fallen into the equipment, 
the equipment has been exposed to rain or moisture, does not operate normally, 
or has been dropped.

15) For products that are a Mains powered device: 
The equipment shall not be exposed to dripping or splashing and no objects filled 
with liquids (such as vases) shall be placed on the equipment. 

Warning! To reduce the risk of fire or electric shock, do not expose this 
equipment to rain or moisture. 

16) For products containing a lithium battery: 
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only 
with the same or equivalent type. 

17) The equipment shall be used at a maximum ambient temperature of 40° C.



Avid
2001 Junipero Serra Boulevard 
Daly City, CA 94014-3886 USA
Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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